
Read Me

Pro Tools HD 8.0.1 on Windows

This Read Me documents important compatibility information, known issues, error codes, and corrections to the guides for 
Pro Tools HD 8.0.1 on Digidesign-qualified Windows systems running a Digidesign-qualified version of Windows. For the 
latest compatibility information, visit the Digidesign website (www.digidesign.com). 

Compatibility

Digidesign can only assure compatibility and provide support for Digidesign-qualified hardware and software configurations. 
For a list of Digidesign-qualified computers, operating systems, and third-party devices, refer to the latest compatibility in-
formation on the Digidesign website (www.digidesign.com/compatibility).

Database File Compatibility

Pro Tools 7.x and higher requires a new Digidesign database file format. Database files created with Pro Tools version 6.x will 
be deleted upon launching Pro Tools 7.x or higher for the first time. Please re-index your drive(s) for faster searches. Refer to 
the Pro Tools Reference Guide for information on indexing DigiBase databases.

Note that DigiBase Pro catalog files will not be deleted but have to be updated. Launching Pro Tools will post a dialog allowing 
you to convert or delete existing catalogs. 

Increased Number of Characters in Memory Locations Comments Field (Item # 83593)

In Pro Tools 7.3 and higher, the number of characters allowed in the Comments field for Memory Locations has been in-
creased. When opening Pro Tools 7.3 and higher sessions in previous versions of Pro Tools, any characters beyond 258 will 
be dropped from the Memory Locations Comment text.

Audible Artifacts during Playback Using the Digidesign WaveDriver (Item #70492)

Audio stutters when playing back using the Digidesign WaveDriver.

Aero Causes Errors at Lower HW Buffer Sizes (Vista Only) (Item #103563)

With Aero enabled in Windows Vista, Pro Tools will not play back without errors at HW Buffer sizes of 128 and below. Turn 
off Aero if you want to use lower HW Buffer sizes.

Automatic Update Notification (Item #108837)

Software Updater will not find an active internet connection when behind a proxy server that requires authentication to gain 
internet access. To workaround this, the client machine with Software Updater needs to be moved out from behind the proxy 
or the proxy needs to allow HTTP access via port 80 without requiring authentication.
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Known Issues
The following sections document known issues you may encounter when using Pro Tools 8.0.1, along with workarounds if 
they exist.

Pro Tools

Default Drive Defragmenting Task Corrupts Audio Files (Vista Only) (Item #111562)

If Pro Tools is allowed to sit open and idle after 12:00 AM on Wednesdays, Windows Vista will run a scheduled disk defrag-
mentation task at 1AM which can result in corrupted session or audio data. Digidesign recommends either disabling the 
scheduled disk defragmentation task or making sure Pro Tools is not open if a scheduled disk defragmentation task is pend-
ing.

Session Templates Retain I/O Settings and Some Preferences, Display Settings, and Window Layouts (Item #111605)

Pro Tools Session Templates retain the I/O settings and some of the preferences, display settings, and window layouts from 
the system on which the template was created. Consequently, created a new session based on a template restores several ses-
sion properties from the original system. These properties are retained by Pro Tools until you change them or another session 
or template is opened that replaces them. This also means that if a new blank session is created after using a template, the 
properties from the template will be used for the new session.

The properties retained from templates include default track height, view settings, window size and position, and I/O Setup. 
You can update templates by making the desired changes, using the File > Save as Template command (be sure to select the 
“Install template in system” option), and then selecting the template you want to replace.

Windows Erroneously Reports that Pro Tools has Stopped Responding (Vista Only)

Clicking on the splash screen while Pro Tools is launching can result in a Windows Vista error stating that Pro Tools has 
stopped responding. Pro Tools is actually still loading normally and will finish launching if you just don’t do anything or if 
you click “Wait for the Program to Respond.”

Unable to Open Sessions Created with Pro Tools 7.4 or Lower that Use the Maximum Available DSP in Pro Tools 8.0.1 
(Item #111490)

Since the surround mixer plug-in is installed by default with Pro Tools 8.0.1, some stereo sessions that use mono output paths 
may use a different DSP allocation than in Pro Tools 7.4 and lower. Older sessions that use mono output paths and use all of 
the available DSP and may not open in Pro Tools 8.0.1. The workaround is to remove the surround mixer plug-in from the 
“Plug-Ins” folder and move it to the “Plug-ins (Unused)” folder so Pro Tools does not use the surround mixer to build your 
mixer. This should make the necessary DSP available to open the session.

Opening Session Created with Pro Tools 7.4 or Lower (Item #: 106746)

When opening sessions created with Pro Tools 7.4 or lower in Pro Tools 8.0.1, all waveform overviews are recalculated. This 
is because Pro Tools now features 16-bit waveform overviews, so all old 8-bit overviews will need to be recalculated. This re-
calculation only needs to happen once.

Possible Performance Issues with New Waveform Overviews (Item #110041, 106801, and 106577)

Calculating waveform overviews in Pro Tools 8.0.1 may cause some one time issues with various operations. Once the over-
views are calculated, system performance will return to normal. Areas where you may notice this are:

Legacy Sessions (Item #110041) When opening Legacy Pro Tools sessions for the first time, if you immediately start play-
back, you may encounter various errors advising you to increase the H/W Buffer size, or to delete tracks, or to remove some 
RTAS plug-ins. This is due to the fact that Pro Tools is re-calculating of the session’s waveform overviews in the background. 
Pausing this task in task manager, or waiting until this task is complete, will resolve the issue. Once the waveform is calcu-
lated, you will not experience this issue again.

For known issues specific to any of the software options for Pro Tools HD, see the DigiTranslator Read Me, the Satellite Link 
Read Me, the Video Satellite Read Me, or the Video Satellite LE Read Me accordingly.
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Playback of Newly Created Regions (Item #106801 and 106577) You may notice a slight drop in normal playback perfor-
mance immediately following a record take or after creating or importing new regions. This is due to the fact that Pro Tools 
is calculating waveform overviews in the background, and is mostly only encountered when recording or creating many re-
gions with long durations. Pausing this task in task manager, or waiting until this task is complete, will resolve the issue. Once 
the waveform is calculated, your session playback performance will return to expected levels.

Some Sessions that use Reason with ReWire Don’t Open in Pro Tools 8.0.1 (Item #111757)

Opening some Sessions that contain Reason ReWire will result in the following Reason error: “Engine not responding. Please 
check your ReWire host.” To workaround this problem, launch Pro Tools and create a new session. Then, insert Reason Re-
Wire on any track. Close the session, but keep Reason open. Then, open the session that uses Reason with ReWire that you 
couldn’t open before.

Fix for Delay Compensation (Item #97571)

Previous versions of Pro Tools sometimes applied incorrect delay when using “Always Compensate” mode. This has been 
fixed. “Always Compensate” mode refers to the ability to apply Delay Compensation to a track where Delay Compensation 
was suspended. Note that to maintain proper monitoring latency on audio tracks with Delay Compensation, it is always nec-
essary to enable “Always Compensate” mode when recording from a source internal to Pro Tools. This makes disk tracks be-
have like Auxiliary Input tracks with regards to Delay Compensation. To enable “Always Compensate” mode, Start-Control-
click (Windows) or Command-Control-click (Mac) the Track Compensation indicator (located in the Mix Window when De-
lay Compensation View is enabled).

CPU Usage Limit May Be Reached when Error Suppression is Enabled (Item #83343)

When enabling Error Suppression at CPU Usage Limit 85% or higher, it may be possible to overload your computer to a point 
at which it is no longer recoverable. To avoid this state, keep your CPU Usage Limit set to 80% or lower when Error Suppres-
sion is enabled.

Screen Redraw May Slow Down at Higher CPU Usage Limit Settings when RTAS Error Suppression is On (Item #82915)

In some cases, you may experience a slowdown in screen redraw or background CPU tasks when RTAS Error Suppression is 
engaged and the CPU Usage Limit is set to 85 percent or above. If you encounter this behavior while using RTAS Error Sup-
pression, open the Playback Engine Dialog and lower the CPU Usage Limit by 5 to 10 percent. 

Windows Has a Limitation of 256 MB when Setting System Memory Allocation for DAE Playback Engine (Item #58237)

Windows XP will allow an absolute maximum of 256MB to be set aside for the non-paged pool (NPP). This means that engine 
configurations requiring more than 256MB cannot be supported in Pro Tools when running on Windows XP. If you attempt 
to configure your Playback Engine settings in such a way as to require more than 256MB, the action will be disallowed and 
the following message will be posted: “A maximum of 256MB may be used to support this playback engine. Try lowering your 
DAE buffer size or choosing an engine with fewer voices.”

Dropped Region Loops when Saving Sessions as Pro Tools 5.1 to 6.9 Format (Items #90102, 90079)

When saving a session as a 5.1 to 6.9 format, a dialog appears informing the user that “Region Loops will be dropped.” As a 
workaround, highlight all audio files and choose Region > Unloop > Flatten before saving the session as a lower version of 
Pro Tools.

Audio Regions on Tick-Based Tracks Do Not Play at the Correct Tempo after Opening a Reason Song with a Different Tempo 
(Item #96710)

Audio regions on tick-based tracks do not play at the correct tempo after opening a Reason song with a tempo that is different 
from the one in your session. To correct this, make any tempo change via the Conductor track or the Manual Tempo input 
and the regions will play back correctly.
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Import Audio Incorrectly Splits a Stereo Interleaved WAV file that contains IXML Metadata into Two Separate Mono Tracks 
(Item #98841)

Import Audio incorrectly splits a stereo interleaved WAV file that contains IXML metadata into two separate mono tracks. 
Please use the workspace instead to drag the file into the Edit window or directly onto a stereo track. 

Importing MP3 or MP4 Files without QuickTime Installed (Item #62994)

If Pro Tools has been run on a system on which QuickTime was not present, but then QuickTime is installed later, there is the 
possibility that Pro Tools has indexed QuickTime files as “Unknown”. These files will remain as unknown even after Quick-
Time has been installed. If this occurs, either delete Digidesign Database files and try again, or navigate in the browser to any 
“Unknown” QuickTime file and select “Update Database for Selected.”

Conversely, if Pro Tools has been run on a system with QuickTime present, but then QuickTime is uninstalled, there is the 
possibility that QuickTime files have been indexed as known audio file types that can no longer be understood by Pro Tools 
since QuickTime is now absent. If this occurs, delete all database files and try again. 

MP3 Codec Exports Non-Copyright Files Only (Item #68985)

The MP3 codec in Pro Tools 7.3 and higher does not have the ability to encode an attribute for the file to be copyrighted. This 
is a limitation of the codec from Fraunhofer. 

Audio Interfaces Connected to Cards 5–7 at 176.4 kHz/192 kHz (Item #67475)

The 176.4 kHz and 192 kHz sample rates support a maximum of four HD Accel or HD Process cards. To use these sample rates, 
any extra I/O interfaces must be removed from the Pro Tools system. 

To reconfigure:

1  Power down the computer and interfaces

2  Remove DigiLink and Loop Sync and Word clock connections from I/Os connected to HD cards #5 and higher. 

3  Be sure to reconfigure Loop Sync and Word clock connections on the supported I/O interfaces.

After powering up, you may then use the 176.4 kHz or 192 kHz sample rates on your Pro Tools system.

Declaring Legacy Peripherals (Item #68381)

In certain I/O configurations, after declaring legacy peripherals in the Hardware Setup dialog, the legacy peripherals may not 
appear in the I/O Setup dialog. They will appear after you quit and re-launch Pro Tools.

Changing Settings on Legacy Peripherals (Item #69070)

In some hardware configurations after using Pro Tools at sample rate higher than 48 kHz, some legacy peripherals may not 
be identified and peripherals settings won't be modifiable in the Hardware Setup dialog, although such peripherals can be 
used in the session. If this occurs, un-declare legacy peripherals in Hardware Setup dialog and declare them again.

Issues with Kensington Mouse and Drivers

The following may occur when using a Kensington mouse with Pro Tools: 

• Alt key sticks when Zooming (Item #61823) 

• Stuck Shift Key (Item #62376)

• Stuck Control Key (Items #61830, #62066, #61980, #61988, #62348, and #62559). 

To clear stuck keys, press them again. If problems continue, try removing the Kensington drivers. 

Waveforms Fail to Display During Long Recordings (Item #60719)

When making a long record pass, the waveforms may stop drawing after 20 to 30 minutes. The overviews are calculated after 
the session is re-opened.
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Error Message “Could Not Complete Your Request Because the System Cannot Find the File Specified (2)” (Items #50454 
and #50457)

This message can appear while logged into a non-administrative account and doing either of the following: 

• Performing destructive AudioSuite processing

• Locking files in the Workspace browser 

This is possibly because the audio file has read-only permissions. In order to correct this, you must be able to log into an ad-
ministrative account in Windows XP and change the permissions of the audio file so you have full read and write access to 
the audio file. If you do not have administrative access of the computer, then you must either contact the administrator of 
the computer to resolve this problem, or use the File > Save Copy In command to create a copy of the session with all of its 
audio files.

Error Message “Could Not Complete the Bounce to Disk Command Because Access is Denied” (Item #50488)

Bouncing to disk to the root level of any SCSI drive while logged into a non-administrative account may cause the following 
error: “Could not complete the bounce to disk command because Access is denied.” This is because Windows XP doesn't al-
low files to be created at the root level of a drive while logged into a non-administrative account. To get around this problem, 
you must create a sub-directory and redirect your session bounce to the newly created directory. 

Recalculating Overviews while Logged into a Non-Administrative Account (Item #50537)

Recalculating overviews of audio files while logged into a Non Administrative account may cause the following error in the 
Task window in Pro Tools: “Access denied. (5).” This is probably caused by the audio files having read-only permissions. 

In order to correct this, you must be able to log into an administrative account in Windows XP and change the permissions 
of the audio file so you have full access to the audio file. If you do not have administrative access of the computer, then you 
must either contact the administrator of the computer to resolve this problem, or use the File > Save Copy In command to 
create a copy of the session with all of its audio files.

Performing Commands which Require Saving a Session on a Non-Administrative Account (Item #53335)

When logged in as non-administrative user, and opening a session which was copied from CD-ROM (or external hard drive) 
onto the system, executing any command which causes Pro Tools to save the session will cause the Access to be denied. To 
resolve this problem, first save the session using File > Save As or File > Save Copy In.

Song Position Pointer Messages are Not Received in “Continuous Scroll with Playhead” Mode (Item #54587)

When in “Continuous Scroll with Playhead” mode, Synchronic, Intakt (Native Instruments) and other MIDI-enabled plug-
ins stop receiving Song Position Pointer messages, and cannot catch up when starting and stopping playback.

Intermittent Shuttle Lock Commands Ignored (Item #47155)

Shuttle Lock commands occasionally appear to have been ignored. Click once on the Transport pop-up and the functionality 
will return.

Timestamping and DestructivePunch-Prepared Tracks (Item #67054)

Since it is possible to change the session start after tracks prepared for DestructivePunch have been created, the time stamp 
for the track(s) may be inaccurate. If accurate time stamps are a priority, then re-timestamp the regions created using the time-
stamping function in the Region List.

Some QuickTime Audio Formats Cannot Be Imported (Items #58792, 73064)

The audio from QuickTime movies with Apple Lossless or AMR audio compression cannot be imported into Pro Tools. Use 
QuickTime Pro or another application to convert the audio to another format prior to import.

Apple Lossless Codec Is Not Supported for Bounce to QuickTime Movie (Item #75224)

Pro Tools 7.3 and higher does not support the Apple Lossless audio codec. Choosing it from the Bounce to QuickTime Movie 
Audio Compression dialog will result in a movie without usable audio.
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Automation Window Update when Writing Automation (Item #111105)

When writing automation on Volume, Pan, and so on, the corresponding buttons in the Automation window provide no in-
dication that automation on the related control is being written. You will need to observe the automation buttons on tracks 
in Mix or Edit windows to see an indication that automation is being written.

DigiBase

Conversion of Large DigiBase Catalogs May Take Hours (Item #77636)

Converting legacy Catalogs can take hours for extremely large catalogs (10,000+ referenced files). Because of this we suggest 
you plan on converting your catalogs at an appropriate time that will not interfere with normal productivity. You will be 
prompted at each launch of Pro Tools until the Catalogs are converted, and you may choose to ignore such prompts until you 
are ready to convert them. Once converted, you will not see this problem again.

File and Disk Management

Auto-Saving with External Hard Drives that Have Little Free Space Can Result in Data Loss (Item #94260)

When recording to hard drives that do not have much free space available and when the Auto-Save preference is turned on, 
it is possible to completely fill your record drives, and cause data loss. While this occurrence is rare, it can also result in ex-
ternal drives that will fall offline and not be able to used on the Windows system. It is recommend that you do not allow your 
record drives to become completely full, and that you manually back up your projects on a regular basis.

Pro Tools Unable to Relink to Audio Files and Fade Files That Have Illegal Characters when Mac/PC Compatibility Not 
Enabled (Item #60728)

A Pro Tools session is unable to relink to audio files and fades that have illegal characters if the session was copied in a version 
of Pro Tools earlier than 7.0 without the Enable Mac/PC Compatibility option enabled. The workaround is to open the Di-
giBase Project Browser and manually relink each file by File ID.

Unable to Open Mac Sessions from Workspace if Illegal Characters Were Converted to Underscore Symbol (Item #60243)

You will not be able to open a Macintosh-originating session from the Workspace if the session name contains illegal char-
acters that were converted to underscore. The workaround is open the session using the File > Open Session command.

Loss of Sharing Information when Unmounting Drives from Pro Tools Workspace (Item #46273)

Information relevant to the Shared Folders and Permissions for a given drive, or the folders within it, is lost when a drive is 
unmounted from within a Pro Tools Workspace. If you wish to re-mount the drive, go to Control Panel > Administrative 
Tools > Computer Management > Disk Management, find the drive, and re-assign the drive letter.

Missing files when opening a session that was saved using Save Copy In with Preserve Folder Hierarchy (Item #74454)

The Preserve Folder Hierarchy feature is designed so that sessions with media split between multiple volumes can be easily 
moved between systems while retaining folder hierarchy. In order for media files to be automatically found, manually copy 
or create a folder at the root level of each volume with the session name that contains the Audio Files or Video Files folder. 
Or, manually relink to the missing files at their current location. 

Multiple Files with the Same Name Do Not Relink Properly when Session Copy Is Saved with Preserve Folder Hierarchy 
(Item #79868)

When saving a session copy with Preserve Folder Hierarchy checked, files with the same name may not relink properly when 
using Manual Relink. When opening the session copy, use Automatically Relink to locate the correct files. If the session has 
already been opened using Manual Relink and some files are still offline, select Relink Offline in the Project Browser to man-
ually relink the remaining files.
Pro Tools HD 8.0.1 on Windows — 7/24/09 6



Elastic Audio

Changes to Elastic Audio Algorithms in Pro Tools 8.x (Item #109141)

Several changes have been made to Elastic Audio signal processing in Pro Tools 8.0 and higher. In some cases, you may notice 
improvements with timing accuracy of events when time warping audio using the Polyphonic algorithm. In other cases, you 
may notice sustained low frequency content sounds smoother when time stretching using the Rhythmic algorithm. The X-
Form algorithm was upgraded as well, and exhibits better pitch coherency on certain polyphonic audio sources. While the 
aim was to improve sonic performance, it is important to note that sessions using Elastic Audio processing can sound differ-
ent when played in Pro Tools 8.x than the same sessions did in Pro Tools 7.4. To reproduce Elastic Audio processing identical 
to Pro Tools 7.4, you can replace Elastic Audio version 8.0.1 with version 7.4 and commit your audio tracks if necessary. Note 
that version 7.4 does not support Elastic Pitch. 

Change Between Pro Tools 7.4 and 8.x in how Transient and Warp Markers Affect Sound Quality (Item #105159)

Both the Polyphonic and Rhythmic Elastic Audio algorithms rely on transient analysis to achieve optimal fidelity and timing 
accuracy. Reducing event sensitivity, and consequentially removing Analysis or Warp markers, may adversely affect the 
sound quality and timing of elastic regions. Conversely, an overabundance of Analysis markers or Warp markers, can also ad-
versely affect sound quality. For best results, make sure that Analysis markers are reasonably correct vis a vis the musical 
events in an audio region. Note that to achieve the highest sound quality, the Polyphonic algorithm in Pro Tools 8.x is more 
reliant upon Analysis markers than in Pro Tools 7.4.

Unusual Audio “Warble” with Polyphonic Elastic Audio (Item #103038 and #108845)

In some cases, some audio that is being processed with the Polyphonic Elastic Audio algorithm may sound “warbly.” If this 
occurs, try adjusting the Window Length control in the Polyphonic Elastic Audio Plug-in window until the warble goes away. 
If you are opening a session that previously used the default Window Length setting in Pro Tools 7.4.x, which was 30 ms, a 
recommended starting point would be 40 ms. 40 ms is also the new default parameter value for the Polyphonic Elastic Audio 
algorithm in Pro Tools 8.x.

Real-Time Elastic Audio Tracks Do Not Show Accurate Waveforms (Item #98343)

When using Elastic Audio Real-Time Processing, Pro Tools displays the varispeed waveform in Waveform view no matter 
which algorithm you are using. This is done because all of the Elastic Audio processing is done in real-time and the waveform 
is a prediction of what it will sound like. Switching to Rendered mode will give you an actual representation of the audio as 
rendered by the algorithm you are using.

Maintaining Phase Coherency with Elastic Audio Pitch Processing (Item #106002)

When there is Elastic Audio Pitch processing enabled on a track, switching from Polyphonic, Rhythmic, or X-Form to Mono-
phonic or Varispeed can disrupt phase coherency. To preserve phase coherency in this case, be sure to clear all Elastic Audio 
Pitch processing from the track before switching to the Monophonic or Varispeed algorithm.

Certain Audio Files Cannot Be Calculated or Cleared of Elastic Analysis in Workspace Browser (Item #89026)

There are some rare cases where a file will have a file suffix of a file format supported by Elastic Audio (either .WAV or .AIF), 
but the Pro Tools Workspace Browser will not allow calculation or clearing of elastic analysis. The browser menu items Cal-
culate Elastic Analysis and Clear Elastic Analysis will be greyed out. In these cases, the file may actually be in a non-supported 
format. To check the file’s format, look at the Format column in the Workspace browser. If a file format other than WAV or 
AIFF is shown (such as QuickTime), then the file cannot be calculated or cleared of elastic analysis. Note that these non-sup-
ported files can still be previewed in tempo, as well as elasticized once imported into a session.

Drift in an Audio File May Occur when Using Elastic Audio and the Monophonic or X-Form Algorithms (Item #96151)

Drift in an audio region may occur when using elastic audio depending on how much the regions is expanded or compressed 
when using the Monophonic or X-Form algorithms. If you are using elastic audio with material that contains transient in-
formation in it that you would like to keep from drifting, you should use the Polyphonic or Rhythmic algorithms.
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Tempo Maps Made from Bar|Beat Marker Generation in Beat Detective Cause Region Groups in Rendered Mode to Fall 
Offline (Item #97993)

A tempo map made from Bar|Beat Marker Generation in Beat Detective will cause region groups in Rendered mode to fall of-
fline. The workaround is to make an edit to the offline region and then toggle the Elastic Audio from rendered to real-time 
and then back to rendered.

Default Input Gain Preference Is Only for Elastic Audio Imported at Session Tempo (Item #96725)

The Default Input Gain preference in the Elastic Audio section of the Processing Preferences page is for Elastic Audio Imported 
at Session Tempo only. This preference option will not function unless Preview in Context is enabled in Workspace, and/or 
“Drag and Drop from Desktop Conforms To Session Tempo” is enabled in the Processing Preferences page.

Displayed Timebase is Incorrect after Importing Elastic Audio Tracks (Item #111299)

The incorrect timebase is displayed after importing Elastic Audio tracks to existing tracks with opposite timebase. You will 
need to manually select the correct timebase for the affected tracks.

Elastic Audio Regions on Playlist Lanes Are Not Rendered (Item #111882)

In Playlists View, any Elastic Audio regions on Playlist lanes are not rendered (waveform is “off-line”) when changing the 
track’s Elastic Audio processing from Real-Time to Rendered.

Region Groups Containing Elastic Audio Are Not Recognized as Elastic if the Region Group Itself Has Not Had Any Elastic 
Functions Applied (Item #92770, #97107)

If a region group contains Elastic Audio inside it, but no Elastic Audio operations have been performed on the outermost level 
of the region group itself, then the region group will not register as Elastic Audio. When used to create a new track, the track 
will not automatically be Elastic Audio–enabled, and the elastic audio inside the region group will be rendered using the de-
fault Elastic Audio plug-in for the session. As a workaround, add a warp marker to the region group to force it to register as 
an elastic region. Or, create an Elastic Audio–enabled track first, then add the region group to it.

Cannot Import Elastic Audio Tracks with the Consolidate From Source Media Option (Item #96404)

Use Copy from Source Media to import Elastic Audio tracks. 

Timing Inaccuracy in Audio Files Converted from CAF and MP3 with Preview In Context Enabled (Item: 111064)

Audio files converted from CAF and MP3 with Preview In Context enabled can cause timing inaccuracies (gaps in the audio 
and inner-region asynchronous transients issues). This is inherent with compressed file formats.
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Plug-ins

TC Master X 3.9 is not Compatible with Pro Tools HD (Windows Vista Only) (Item #106306)

When inserting the TC Electronics plug-in Master X version 3.9 on a track in Pro Tools HD, Pro Tools quits unexpectedly. If 
you are running Pro Tools HD on Windows Vista, it is recommended that you do not install this plug-in.

AudioSuite and Region Groups (Item #64410)

AudioSuite plug-ins handle Region Groups in the Region List slightly differently than audio files. With audio files, an Audio-
Suite process can be applied to all copies of a unique audio file which appear in your session by selecting your target as Region 
List in the AudioSuite plug-in window and selecting Use in Playlist. However, if your target is set to Region List in the Audio-
Suite plug-in window while you have a Region Group selected, Pro Tools does not recognize the Region Group as processable 
audio and will present a No Audio was Selected error. This is because a Region Group is not treated as audio until it is actually 
used in a track.

To apply an AudioSuite process to all copies of a Region Group in a session at once, do the following:

1  Select the Region Group to be processed.

2  From the Region List menu, select Ungroup All. All elements of the group will remain selected.

3  Perform AudioSuite processing.

4  From the Region List menu, select Regroup.

When prompted, select Modify to apply the AudioSuite Process to all copies of the Region Group in the session, or Copy to 
apply it only to the selected Region Group.

Plug-in Find and Relink with File Types not Supported by Pro Tools (Item #111704)

Find and Relink will not be triggered by plug-ins in situations where plug-ins supporting Find and Relink are missing links to 
file types that are not natively supported by Pro Tools (such as REX files). To have full Plug-in Find and Relink support, the 
file types used in plug-ins must also be supported by Pro Tools.

Control Surfaces

Trim Scrub and Trim Shuttle Don’t Work on Regions with Fades (Item #111316)

If a region has fades, Trim Scrub and Trim Shuttle don’t work when trying to trim using a control surface. To work around 
this problem, remove any fades on the region, then execute the Trim Scrub or Trim Shuttle, and then restore the fades.

Used HW Output Path Indication (Item #101095)

In Assign Matrix, Insert mode the used HW output path will not have amber background indicating that it's already assigned 
after switching to a different insert on the same track.

Color Indication on Plug-in Controls in Learn Mode (Item #102710)

When a plug-in is in Learn mode and the track with this plug-in is not focused on the main ICON unit, all automation LEDs 
in the Plug-in window will be red if the track is in one of auto write modes. This conflicts with red color indication on the 
Plug-in control, which is armed for mapping. The workaround is to set the track with plug-ins to Read automation mode.

Send/Pan mode on D-Command for Sends F–J (Item #82871)

In Pro Tools 7.3 and higher, if you save a session on D-Command which is in Send/Pan mode for Sends F-J, the session will 
open in previous versions of Pro Tools with the channel fader controlling that Send level, as if in Flip mode. To avoid this, 
open the same session in Pro Tools 7.4, take the session out of Send/Pan mode, and re-save the session.

For known issues about specific plug-ins, see the Digidesign Plug-ins Read Me.
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Downloading Firmware for D-Control or D-Command (Items #46015, #46990, #58102)

While downloading firmware updates on D-Control or D-Command, do not adjust any controls in the main unit’s monitor-
ing section, or transfer files on your computer. Doing so may interfere with a successful firmware download.

Shortcuts for Zooming on D-Control or D-Command 

D-Control and D-Command now support the following: 

To zoom in on the current selection:

Alt-press (Windows) or Option-press (Macintosh) the Zoom switch. 

To zoom out to show the entire session:

Double-press the Zoom switch. 

SignalTools Meter Ballistics on Control Surfaces (Item #74340)

SignalTools RMS, VU, BBC, Nordic and DIN meters will display inaccurate decay times when viewed on a control surface. Un-
affected types are Peak, VENUE, and Peak + RMS, which only reports the Peak meter to the control surface. The attack times 
of the affected meters are not affected, only the decay times. All meter types display accurately in the plug-in window.

Pro Tools Transport Must Be Stopped when Recalibrating ICON Faders (Item #78074)

The transport in Pro Tools must be stopped when recalibrating faders on D-Command and D-Control. If one or more faders 
need calibration do the following: Stop playback, enter Utility mode, press TEST, press FADER, and press RECAL. After reca-
librating faders. exit Utility mode.

MIDI

Sibelius Does Not Launch when Using the Send to Sibelius Command (Item #110405)

When you first install any of the supported Sibelius packages (Sibelius, Sibelius First, or Sibelius Student), the Send to Sibelius 
command in Pro Tools will return a false error stating that Sibelius is not installed in the system. To avoid this problem, 
launch Sibelius manually and create a score document. This will only needs to be done once, after which the Send to Sibelius 
command should function properly.

Record-Enabled MIDI or Instrument Tracks Play Out of Time when Punching In (Items #70082, 98835)

With Delay Compensation enabled, the underlying data on MIDI or Instrument tracks plays out of time when attempting to 
punch-in to a record-armed MIDI or Instrument) track.

When Using Import Session Data on a MIDI Track with Real-Time Properties Enabled and Set to Using Diatonic 
Transposition, Transposition is Based on the First Key Signature in the Session Only (Item #81666)

When importing session data from a session that includes multiple key signatures and a MIDI or Instrument track with the 
“Transpose in Key” Real-Time property enabled, the transposition will be based only on the first key in the session. This can 
be corrected by toggling the Real-Time Properties off and on, at which point the diatonic transposition will be correct for each 
key.

MIDI Inputs and Outputs Seem to be Missing from the Screen, or Appear to Scroll Off the Screen (Item #53611)

When the screen resolution is set to 1024x768, users with large MIDI configurations might notice MIDI inputs/outputs miss-
ing from the MIDI input/output selectors. Resize the screen to a higher resolution to resolve this problem.

Unavailable MIDI Input Paths for MIDI and Instrument Tracks are not Indicated (Item #111221)

The device or path name for MIDI Input on MIDI and Instrument tracks is not italicized and grayed out when opening a ses-
sion on a system where the device or path are not actually present.
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Latency When Recording MIDI Tracks with Wait for Note and a Virtual Instrument (Item #43068)

When recording a virtual MIDI instrument track in Wait for Note mode, latency occurs at Bar 1|Beat 1.

Synchronization and Machine Control

Recording with Serial Time Code (Item #64636)

Occasionally, it is possible for the Tascam DA-98 servo lock bit behavior to cause Pro Tools to think the DA-98 is servo locked 
before it actually is. This could cause a synchronization offset when Pro Tools locked to serial time code generated from a DA-
98. Pro Tools will now handle these cases, but if you experience this problem, try increasing the amount of frames to 10 in 
the “Delay before locking to Timecode” preference. 

The “Machine Cues Intelligently” Preference Should Not Be Used with Non-Linear Decks (Item #46200)

Pro Tools overshoots and posts an “Error Cueing Machine” dialog if the Machine Cues Intelligently preference is checked 
when using non-linear playback devices.

Video

Video Capture Aborted Due to Dropped Frames (Item #82895)

Sessions with medium to large CPU loads may be unable to capture video reliably. Deactivate CPU heavy tasks, such as Virtual 
synths and heavy timeline automation for as long as you need to record video. Video playback will not be affected and pre-
vious CPU tasks can be restored.

Unsupported QuickTime Video Formats (Items #72933, 72956, 72958, 72961)

Several video formats supported in QuickTime are not supported in Pro Tools. These include .DivX, .flc, .m4v and .3gp format 
movies. Attempting to import these will generate errors or will fail to import.

Standard Definition QuickTime Movies Are Rendered as 16:9 Anamorphic Play Back in Pro Tools at 4:3 (Item #109076)

Standard Definition QuickTime movies rendered with 16:9 an anamorphic Scaled Size of 853x480 play back in Pro Tools at 
4:3 or 720x486 resolution. The Scaled Size attribute of QuickTime movies is ignored by Pro Tools. To workaround this prob-
lem, render the movie letterbox natively within the 720x486 pixel dimension.

Dragging from Windows Explorer in Shuffle Mode Doesn't Work Correctly with Video (Item #78451)

Dragging a Video file from the desktop to the Edit window while in Shuffle mode will always place the video at session start, 
overwriting existing video regions in that location.

Pro Tools UI May Slow Down with Densely-Edited QuickTime Movie Track (Item #77720)

Pro Tools may begin to respond more slowly and update less often as a session with one or more QuickTime video tracks be-
comes more and more densely edited. If, while working with heavily edited QuickTime clips, Pro Tools responsiveness begins 
to decline, use the Bounce to QuickTime Video command, then import the bounced movie.

Several QuickTime Codecs Are Distorted when Played Out through an Avid Mojo (Items #73328, 73332, 73334, 73341, 
73342, 73343, 73344)

Pro Tools 7.3 and higher will play most standard QuickTime files via Avid peripherals; however, only DV25 and h.264 format 
streams have been thoroughly tested, Several legacy QuickTime codecs are distorted when played back through the Avid 
Mojo. These include:

• Uncompressed .avi files

• Uncompressed .mov files (i.e. Apple “none” compression), except 32-bit movies.

• QuickTime movie (.mov) files using the Graphics, Animation, Cinepak, or Video codecs.

These formats will display properly when played back on the desktop.
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MPEG-1 and MPEG-2 Video Freezes at Edit Points (Item #79182)

Editing MPEG-1 & MPEG-2 video is not officially supported. If you experience this problem, try switching playback to the 
Video window, or convert the movie to a supported format using a 3rd party application. Removing the audio from an MPEG-
1 or MPEG-2 movie with a 3rd party application may also fix the problem.

Audio from Muxed MPEG-1 and MPEG-2 Movies Cannot Be Imported and Will Be Heard in a Bounced Movie (Item #76063)

Unlike other QuickTime formats, MPEG-1 and MPEG-2 movies store audio and video in a single multiplexed track, called a 
“muxed.” track. Pro Tools cannot separate the audio from video for these types of movies. As a result, you will not be able to 
import the audio from an MPEG-1 or MPEG-2 movie. Also, if you Bounce to QuickTime using an MPEG-1 or MPEG-2 movie 
as a source movie, the original audio from the movie will be present in the bounced movie (even though it will not be heard 
while working with the movie in Pro Tools). To import audio from an MPEG-1 or MPEG-2 file, use a third party application 
to “demux” the MPEG stream.

When Using Bounce to QuickTime, Do Not Bounce to an Existing Movie Name (Item #76768)

If you use the Bounce to QuickTime command and use the same name as an existing movie, the bounce may fail. It is best 
to use a unique name for each bounce, or delete the previous movie from the drive prior to bouncing with the same name 
(rather than choosing to replace the existing file).

Video Track’s Video Format Doesn't Match Session's Video Format when Switching between NTSC and PAL (Item #77328)

In some cases when switching from NTSC to PAL or from PAL to NTSC, a newly created Avid video track will display the 
wrong video format. Trying to record to this track will give the error, “Session frame rate must be compatible with either PAL 
or NTSC.” Toggling the Video Format selector from NTSC to PAL or from PAL to NTSC in the Session Setup window will clear 
this problem.

Pro Tools Cannot Record Video (Item #59710)

If a 23.976 or 24p session is changed to 29.97, video cannot be recorded until Pro Tools is closed and relaunched.

General Localization 

AAF/OMF Sequences with Non-English Characters Import with Garbled Region Names or Won't Relink 
(Items #95851, #95857, #96279) 

If an AAF/OMF sequence containing files or region names with non-English characters is exported from a Mac-based 
Pro Tools 7.3.1 system (or lower), it may not import correctly into Avid Media Composer, XP-based Pro Tools systems, or 
Pro Tools 7.4 systems on Windows or Mac. Conversely, AAF/OMF sequences with non-English characters exported from any 
Pro Tools 7.4 system (or higher) may not import correctly into a Mac-based Pro Tools 7.3.1 (or lower) system. To relink the 
files, select “Manually Find and Relink,” then deselect all options except “Find by file ID.” Region names may appear garbled.

Error Messages

Error –6031 During Playback (Item #32637)

If you encounter a –6031 error while playing back a session with dense MIDI or automation, stop playback, save and close the 
session, quit and re-launch Pro Tools, then re-open the session before resuming playback.

DAE Error –9132

If a –9132 error occurs during Bounce To Disk (even with the highest Hardware Buffer setting selected), bus the desired tracks 
to the appropriate number and format (mono or stereo) of audio tracks, then record them to disk instead of bouncing.
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Error –5000 (Unknown Error) when Launching Pro Tools (Item #36130)

On a system with multiple partitions, if different Interlok Pace versions are installed on different partitions, Pro Tools will re-
port an “Unknown –5000 error” on launch. To avoid this problem, install the same Pace components on all partitions on 
your system.

Error –6042

If you repeatedly encounter –6042 errors, open the System Usage window and check the PCI gauge. If the gauge is peaked, you 
will need to reset the PCI bus. To reset the PCI bus, make all tracks inactive and start playback. If you still encounter a –6042 
error, quit and relaunch Pro Tools, open the Playback engine dialog, and change the Number of Voices to a setting that uses 
fewer per DSP. 

Error –6074 When Toggling All Plug-ins Between Active and Inactive Mode During Playback (Item #55049)

In large sessions, deactivating and reactivating all the plug-ins simultaneously can cause Pro Tools to post the following error: 
“The engine DSP ran into the TDM2 deadband. Too many I/Os to the TDM2 chip (–6074).” To resolve the problem, activate 
and deactivate plug-ins in smaller groups.

DAE Error –9073 when Recording to a FireWire Drive and the 2 GB File Limit is Reached (Item #42611)

When the 2 GB file limit is reached during recording to FireWire drives, a –9073 error is posted instead of the expected “Re-
cording has been terminated because a disk is full” dialog. This error is benign, and does not signal any data loss or problem 
with the hard drive.

DAE Error –9073 other than when Recording to a FireWire Drive and the 2 GB File Limit is Reached

If you encounter a –9073 error, refer to the Answerbase for possible causes and solutions (http://answerbase.digidesign.com).

DAE Error –9128

In sessions with high sample rates (96 kHz or higher), you may need to set the Hardware Buffer Size to 512 or more to avoid 
–9128 errors during playback with RTAS plug-ins or dense automation.

DAE Error –9155

In sessions with high sample rates of 96 kHz or more, you may need to set the Hardware Buffer Size to 512 or more to avoid 
–9155 errors during playback with dense automation.

DAE Error –9735

When Pro Tools reaches the end of its time limit in the Timeline, or if Pro Tools has been in continuous play for longer than 
the maximum time limit, you will encounter a DAE error –9735. The maximum time limit for Pro Tools depends on the ses-
sion sample rate. For more information, see the Pro Tools Reference Guide.

Corrections to Pro Tools Guides

What’s New Guides
Part Number 9327-59101-00 REV A 11/08 

The following identifies corrections to and omissions from the What’s New in Pro Tools HD 8.0 Guide.

Time Locking Regions

On page 38 of the What’s New in Pro Tools HD 8.0 Guide, the keyboard shortcut tip for Time Locking regions incorrectly states, 
“Press Shift+T to Time lock or unlock the selected region.” 
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Corrections:

The keyboard shortcut tip should read, “Press Alt+Start+L (Windows) or Option+Control+L (Mac) to Time lock or unlock the 
selected region.”

Pro Tools Reference Guide
Part Number 9106-59126-00 REV A 11/08

The following identifies corrections to and omissions from the Pro Tools Reference Guide.

Toolbar Focus

On page 25 of the Pro Tools Reference Guide, documentation of Toolbar focus is incorrectly omitted.

Corrections:

The following section for “Toolbar Focus” should be added right after the section on “Keyboard Focus:”

Toolbar Focus

In the Edit window, the MIDI Editor pane can be displayed in addition to the Tracks pane (View > Other Displays > MIDI Editor). 
When the MIDI Editor pane is displayed, there are two separate Toolbars and Timelines in the Edit window: one for the Tracks 
pane and one for the MIDI Editor pane. Only one Toolbar and Timeline can be focused for Menu and Toolbar commands (in-
cluding the corresponding keyboard shortcuts) at a time. The focused Toolbar displays a orange outline. 

If Keyboard Focus for the Edit window is enabled, it follows the selected Toolbar focus.

To enable Toolbar focus for the Tracks pane, do one of the following:

Click the Toolbar at the top of the Edit window.

– or –

Press Control+Alt+4 (Windows) or Command+Option+4 (Mac).

To enable Toolbar focus for the MIDI Editor pane, do one of the following:

Click the Toolbar right above the MIDI Editor pane.

– or –

Press Control+Alt+5 (Windows) or Command+Option+5 (Mac).

Pro Tools LE System Capabilities

On page 34 of the Pro Tools Reference Guide, the final paragraph incorrectly states, “Pro Tools LE systems provide up to 128 
Auxiliary Input tracks, a total of 32 internal mix busses, and up to 5 inserts and 10 sends per track (depending on your com-
puter’s processing capacity). In addition, Pro Tools LE systems support up to 32 Instrument tracks and 256 MIDI tracks. 
Pro Tools LE also supports a single QuickTime video track.”

Corrections:

The paragraph should read, “Pro Tools LE systems provide up to 128 Auxiliary Input tracks, a total of 32 internal mix busses, 
and up to 10 inserts and 10 sends per track (depending on your computer’s processing capacity). In addition, Pro Tools LE sys-
tems support up to 32 Instrument tracks and 256 MIDI tracks. Pro Tools LE also supports a single QuickTime video track.”

Zoom Toggle Preferences

On page 90 and also on page 455 of the Pro Tools Reference Guide, the paragraph on the “Separate Grid Settings When Zoomed 
In” preference incorrectly states:

Separate Grid Settings When Zoomed In When selected, this option retains the same (current) grid setting when zoom tog-
gling in or out. When this option is deselected, the grid setting stored with Zoom toggle is recalled when zoom toggling in. 
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Corrections:

The paragraph should read:

Separate Grid Settings When Zoomed In When selected, the Grid setting stored with Zoom toggle is recalled when zoom tog-
gling in. When this option is deselected, the same (current) grid setting is used whether zoom toggling in or out. 

Notes View for MIDI and Instrument Tracks

On page 435 of the Pro Tools Reference Guide, the ability to use a mouse with a scroll wheel to scroll up or down in Notes View 
is omitted.

Corrections:

The following step should be added to the procedure for scrolling the Notes display up or down for a MIDI or Instrument 
track: “If you have a mouse with a scroll-wheel, move the cursor over the track and Control-Alt-Start-scroll (Windows) or 
Command-Option-Control-scroll (Mac) up or down to scroll the notes display up or down.”

Time Locking Regions

On page 731 of the Pro Tools Reference Guide, the keyboard shortcut tip for Time Locking regions is incorrectly states, “Press 
Shift+T to Time lock or unlock the selected region.” 

Corrections:

The keyboard shortcut tip should read, “Press Alt+Start+L (Windows) or Option+Control+L (Mac) to Time lock or unlock the 
selected region.”

Dragging and Dropping Plug-in Settings Files

On page 891 of the Pro Tools Reference Guide, the section on “Dragging and Dropping Plug-in Settings Files” erroneously states 
that you can drag and drop plug-in settings files from Windows Explorer or the Mac Finder to inserts and plug-in windows. 

Corrections:

The section on “Dragging and Dropping Plug-in Settings Files” should read:

To insert a plug-in by drag and drop:

Drag and drop a plug-in settings file from a DigiBase browser to an Insert in the Mix (or Edit) window.

To change a plug-in preset by drag and drop:

Drag and drop a plug-in settings file from a DigiBase browser to the plug-in window. The plug-in settings file must be for 
the same plug-in name. For example, you cannot replace a 1-Band EQ 3 with a plug-in setting for 4-Band EQ 3.

Menus Guide
Part Number 9329-52920-00 REV A 11/08

Track Menu

On page 33 of the Pro Tools Menus Guide, the following menu items are not available (however, the keyboard shortcuts for 
these items remain functional):

• Solo Tracks with a Selection

• Mute Tracks with a Selection

• Record Arm Tracks with a Selection

• Input Monitor Tracks with a Selection (Pro Tools HD Only)

Corrections:

The entire “Solo, Mute, Record Arm, and Input Monitor Tracks with a Selection Commands” section should be deleted.
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Trillium Lane Labs Plug-ins Guide
Part Number 9329-59303-00 REV A 11/08

Introduction

The TL Labs AutoPan™ is incorrectly listed as a paid plug-in, but it is included free and installed with Pro Tools 8.0.1. 

Corrections:

TL Labs AutoPan should be listed under Free Trillium Lane Labs Plug-ins and should be deleted from under Paid Trillium Lane 
Labs Plug-ins.
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